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Chapter 1. Troubleshooting

Problems can be related to IBM® Tivoli® Monitoring or the specific agent that you are using.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide. For other
problem-solving options, see [Chapter 4, “Support information,” on page 37.

You can resolve some problems by ensuring that your system matches the system requirements listed in
the Prerequisites topic for the agent in the information center, or in the Requirements topic of the agent
user's guide.

The following activities can help you find a solution to the problem you are having:

+ |[“Gathering product information for IBM Software Support”|

* [“Using logging” on page 2|

+ [“Consulting the lists of identified problems and workarounds” on page 2|

Gathering product information for IBM Software Support

Before contacting IBM Software Support about a problem you are experiencing with this product, gather

the information shown in

Table 1. Information to gather before contacting IBM Software Support

Information type Description

Log files Collect trace log files from failing systems. Most logs are
located in a logs subdirectory on the host computer. See
[“Principal trace log files” on page 4] for lists of all trace
log files and their locations.

For general information about the IBM Tivoli Monitoring
environment, see the Tivoli Enterprise Portal User’s Guide.

Microsoft Hyper-V Server information Version number and patch level

Operating system Operating system version number and patch level
Messages Messages and other information displayed on the screen
Version numbers for IBM Tivoli Monitoring Version number of the following members of the

monitoring environment:

+ IBM Tivoli Monitoring. Also provide the patch level, if
available.

+ IBM Tivoli Composite Application Manager for
Microsoft Applications: Microsoft Hyper-V Server
Agent

Screen captures Screen captures of incorrect output, if any

You can use the pdcollect tool to collect the most commonly used information from a system. This tool
gathers log files, configuration information, version information, and other data. For more information
about using this tool, see the "pdcollect tool" in the IBM Tivoli Monitoring Troubleshooting Guide.

For information about working with IBM Software Support, see [[BM Support Portal Service Requests and|
(http:/ /www.ibm.com/support/entry/portal/Open_service_request/Software/
Software_support_(general)).
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Using logging

Logging is the primary troubleshooting feature in the Microsoft Hyper-V Server agent. Logging refers to
the text messages and trace data that is generated by the Microsoft Hyper-V Server agent. Messages and
trace data are sent to a file.

Trace data captures transient information about the current operating environment when a component or
application fails to operate as designed. IBM Software Support personnel use the captured trace
information to determine the source of an error or unexpected condition. See |Chapter 2, “Trace logging,”|

for more information.

Consulting the lists of identified problems and workarounds

Known problems are organized into types such as those in the following list to make them easier to
locate:

* Installation and configuration
* General usage and operation
* Display of monitoring data

* Take Action commands

Information about symptoms and detailed workarounds for these types of problems is located in
[Chapter 3, “Problems and workarounds,” on page 15

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.
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Chapter 2. Trace logging

Trace logs are used to capture information about the operating environment when component software
fails to operate as designed.

The principal log type is the RAS (Reliability, Availability, and Serviceability) trace log. These logs are in
the English language only. The RAS trace log mechanism is available for all components of IBM Tivoli
Monitoring. Most logs are located in a logs subdirectory on the host computer. See the following
information to learn how to configure and use trace logging:

* [“Principal trace log files” on page 4|

+ [“Examples: Using trace logs” on page 6|

* |“RAS trace parameters” on page 7|

Note: The documentation refers to the RAS facility in IBM Tivoli Monitoring as "RAS1."

IBM Software Support personnel use the information captured by trace logging to trace a problem to its
source or to determine why an error occurred. All components in the IBM Tivoli Monitoring environment
have a default tracing level. The tracing level can be changed on a per-component level to adjust the type
of trace information collected, the degree of trace detail, the number of trace logs to be kept, and the
amount of disk space used for tracing.

Using KHVEventReader to retrieve events

The Event Log attribute group is used by the KHVEventReader application to internally retrieve events
that are specific to Microsoft Hyper-V Server.

The KHVEventReader application name and directory path are as follows:

File name
KHVEventReader.exe

Directory path
install_dir\tmaitmé

The KHVEventReader application is also used to generate a log file based on the values that you set for
the KBB_RASI variable in the KHVENV file. The file name and directory path for the generated log file are
as follows:

File name
hostname_hv_KHVEventReader_timestamp.10g, where timestamp is the time stamp representing the
time at which the KHVEventReader application started. The format for the timestamp is year (y),
month (m), day (d), hour (h), and minute (m), as follows: yyyymmddhhmm

Directory path
installdir\TMAITM6\10gs

You can set the following values for the KBB_RASI variable in the KHVENV file:

* No error tracing: KBB_RAS1 = -none-

* General error tracing: KBB_RAS1 = ERROR

¢ Maximum error tracing: KBB_RAS1 = ERROR (COMP:kqz ALL) (UNIT:kra ALL)

Note: If the value of the trace level is other than -none-, ERROR, or ERROR (COMP:kqz ALL) (UNIT:kra
ALL), the default trace level is set to ERROR.

© Copyright IBM Corp. 2008, 2017 3



Overview of log file management
Knowing the naming conventions for log files helps you to find the files.
Agent log file naming conventions
provides the names, locations, and descriptions of IBM Tivoli Monitoring general RAS1 log files.
The log file names for the Microsoft Hyper-V Server agent adhere to the following naming convention:
Windows systems
hostname_productcode program HEXtimestamp-nn.log
Where:

hostname
Host name of the computer where the monitoring component is running.

productcode
Two-character product code. For IBM Tivoli Composite Application Manager for Microsoft
Applications: Microsoft Hyper-V Server Agent, the product code is hv.

program
Name of the program being run.

HEXtimestamp
Hexadecimal time stamp representing the time at which the program started.

nn Rolling log suffix.

Principal trace log files

Trace log files are located on various systems.

contains locations, file names, and descriptions of trace logs that can help determine the source of
problems with agents.

Table 2. Trace log files for troubleshooting agents

System where log is located File name and path Description
On the Tivoli Enterprise Monitoring |. wWindows: The IBM Tivoli Provides details about products that
Server Monitoring timestamp.log file in |ar€ installed.

the install_dir\Instal1ITM path gf}tﬂllece IOfgging is enabled by
« UNIX: The efault. A configuration step is not

candle_installation.Tog file in required to enable this tracing.
the install_dir/logs path

* Linux: The
candle_installation.log file in
the install_dir/logs path

On the Tivoli Enterprise Monitoring | The Warehouse_Configuration.log Provides details about the
Server file is in the following location on configuration of data warehousing
Windows systems: for historical reporting.

install_dir\InstallITM
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located

File name and path

Description

On the Tivoli Enterprise Monitoring
Server

The name of the RAS log file is as
follows:

* Windows: install _dir\logs\
hostname_ms_timestamp-nn.log

e UNIX: install _dir/logs/
hostname_ms_timestamp-nn.log

* Linux: install_dir/logs/
hostname_ms_timestamp-nn.log

Note: File names for RASI logs
include a hexadecimal time stamp.

Also on UNIX systems, a log with a
decimal time stamp is provided:
hostname_hv_timestamp.log and
hostname_hv_timestamp.pidnnnnn in
the install_dir/logs path, where
nnnnn is the process ID number.

Traces activity on the monitoring
server.

On the Tivoli Enterprise Portal Server

The name of the RAS log file is as
follows:

* Windows: install_dir\logs\
hostname_cq_HEXtimestamp-nn.log

* UNIX: install_dir/logs/
hostname_cq_HEXtimestamp-nn.log

* Linux: install dir /logs/
hostname_cq_HEXtimestamp-nn.log

Note: File names for RASI logs
include a hexadecimal time stamp.

Also on UNIX systems, a log with a
decimal time stamp is provided:
hostname_hv_timestamp.log and
hostname_hv_timestamp.pidnnnnn in
the install_dir/1ogs path, where
nnnnn is the process ID number.

Traces activity on the portal server.

On the Tivoli Enterprise Portal Server

The teps_odbc.10g file is located in
the following path:

* Windows: install_dir\Instal1ITM
e UNIX: install_dir/logs
* Linux: install_dir/logs

When you enable historical reporting,
this log file traces the status of the
warehouse proxy agent.

On the computer that hosts the
monitoring agent

The RASI1 log files are as follows:

* Windows: hostname
_hv_instance_name_khvagent_
HEXtimestamp-nn.log in the
install_dir\tmaitmé\1ogs
directory

These logs are in the following

directories:

* Windows: install_dir\tmaitmé\
logs

Traces activity of the monitoring
agent.
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located

File name and path

Description

On the computer that hosts the
monitoring agent

The agent operations log files are as
follows:

instance_hostname_
HV.LGO is the current log created
when the agent is started.

instance_hostname_
HV.LG1 is the backup of the previous
log.

These logs are in the following
directory depending on the operating
system that you are using:

* Windows: install_dir\tmaitmé\
logs

Shows whether the agent could
connect to the monitoring server.
Shows which situations are started
and stopped, and shows other events
while the agent is running. A new
version of this file is generated every
time the agent is restarted.

IBM Tivoli Monitoring generates one
backup copy of the *.LGO file with
the tag .LG1. View the .LG1 tag to
learn the following details regarding
the previous monitoring session:

* Status of connectivity with the
monitoring server

* Situations that were running

¢ The success or failure status of
Take Action commands

On the computer that hosts the
monitoring agent

The name of the RAS1 log file
created by the KHVEventReader
application is as follows on a
Windows system:
hostname_hv_KHVEventReader_
timestamp.log

The log is in the following directory:
install_dir\tmaitmé6\logs

Traces the activity of the
KHVEventReader application.

Definitions of variables:

follows: yyyymmdd hhmm

* instance refers to the name of the database instance that you are monitoring.

* instance_name refers to the name of the agent instance.

* timestamp is a time stamp with a format that includes year (y), month (m), day (d), hour (h), and minute (m), as

* HEXtimestamp is a hexadecimal representation of the time at which the process was started.

* install_dir represents the directory path where you installed the IBM Tivoli Monitoring component. install_dir can
represent a path on the computer that hosts the monitoring system, the monitoring agent, or the portal.

* hostname refers to the name of the computer on which the IBM Tivoli Monitoringcomponent runs.

* nn represents the circular sequence in which logs are rotated. this value includes a range from 1 - 5, by default.
The first is always retained because it includes configuration parameters.

For more information about the complete set of trace logs that are maintained on the monitoring server,
see the IBM Tivoli Monitoring Installation and Setup Guide.

Examples: Using trace logs

You can open trace logs in a text editor to learn some basic facts about your IBM Tivoli Monitoring

environment.

IBM Software Support applies specialized knowledge to analyze trace logs to determine the source of
problems. The following examples are from the Tivoli Enterprise Monitoring Server log.

Example one

This excerpt shows the typical log for a failed connection between a monitoring agent and a
monitoring server with the host name serverla:
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(Thursday, August 11, 2005, 08:21:30-{94C}kdc10c1.c,105,"KDCLO_ClientLookup") status=1c020006,

"location server unavailable", ncs/KDC1_STC_SERVER_UNAVAILABLE

(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1157,"LookupProxy") Unable to connect to

broker at ip.pipe:: status=0, "success", ncs/KDC1_STC_OK

(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1402,"FindProxyUsinglLocalLookup") Unable

to find running CMS on CT_CMSLIST <IP.PIPE:#serverla>

Example two

The following excerpts from the trace log for the monitoring server show the status of an agent,
identified here as "Remote node." The name of the computer where the agent is running is
SERVERS5B:

(42C039F9.0000-6A4: kpxreghb.cpp,649, "HeartbeatInserter") Remote node SERVER5B:HV is ON-LINE.

(42C3079B.0000-6A4: kpxreghb.cpp,644,"HeartbeatInserter") Remote node SERVER5B:HV is OFF-LINE.

See the following key points about the preceding excerpts:

The monitoring server appends the HV product code to the server name to form a unique
name (SERVER5B:HV ) for this instance of the IBM Tivoli Composite Application Manager for
Microsoft Applications: Microsoft Hyper-V Server Agent. By using this unique name, you can
distinguish multiple monitoring products that might be running on SERVER5B.

The log shows when the agent started (ON-LINE) and later stopped (OFF-LINE) in the
environment.

For the sake of brevity, an ellipsis (...) represents the series of trace log entries that were
generated while the agent was running.

Between the ON-LINE and OFF-LINE log entries, the agent was communicating with the
monitoring server.

The ON-LINE and OFF-LINE log entries are always available in the trace log. All trace levels
that are described in ['RAS trace parameters”| provide these entries.

On Windows systems, you can use the following alternate method to view trace logs:

1.

In the Windows Start menu, click Program Files > IBM Tivoli Monitoring > Manage Tivoli
Enterprise Monitoring Services. The Manage Tivoli Enterprise Monitoring Services window is
displayed.

Right-click a component and click Advanced > View Trace Log in the menu. For example, if you
want to view the trace log of the IBM Tivoli Composite Application Manager for Microsoft
Applications: Microsoft Hyper-V Server Agent, right-click the name of that agent in the window. You
can also use the viewer to access remote logs.

Note: The viewer converts time stamps in the logs to a format that is easier to read.

RAS trace parameters

Pinpoint a problem by setting detailed tracing of individual components of the monitoring agent and
modules

See |[“Overview of log file management” on page 4| to ensure that you understand log rolling and can
reference the correct log files when you manage log file generation.

Setting RAS trace parameters by using the GUI

On Windows systems, you can use the graphical user interface to set trace options.

Chapter 2. Trace logging
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About this task

The IBM Tivoli Composite Application Manager for Microsoft Applications: Microsoft Hyper-V Server
Agent uses RASI1 tracing and generates the logs described in [Table 2 on page 4| The default RAS1 trace
level is ERROR.

Procedure

1. Open the Manage Tivoli Enterprise Monitoring Services window.

2. Select Advanced > Edit Trace Parms. The Tivoli Enterprise Monitoring Server Trace Parameters
window is displayed.

3. Select a new trace setting in the pull-down menu in the Enter RAS1 Filters field or type a valid
string.
* General error tracing. KBB_RAS1=ERROR
* Intensive error tracing. KBB_RAS1=ERROR (UNIT:khv ALL)
* Maximum error tracing. KBB_RASI=ERROR (UNIT:khv ALL) (UNIT:kra ALL)

Note: As this example shows, you can set multiple RAS tracing options in a single statement.

4. Modify the value for Maximum Log Size Per File (MB) to change the log file size (changes LIMIT
value).

5. Modify the value for Maximum Number of Log Files Per Session to change the number of log files
per startup of a program (changes COUNT value).

6. Modify the value for Maximum Number of Log Files Total to change the number of log files for all
startups of a program (changes MAXFILES value).

7. Optional: Click Y (Yes) in the KDC_DEBUG Setting menu to log information that can help you
diagnose communications and connectivity problems between the monitoring agent and the
monitoring server. The KDC_DEBUG setting and the Maximum error tracing setting can generate a large
amount of trace logging. Use these settings only temporarily, while you are troubleshooting problems.
Otherwise, the logs can occupy excessive amounts of hard disk space.

8. Click OK. You see a message reporting a restart of the monitoring agent so that your changes take
effect.

What to do next

Monitor the size of the Togs directory. Default behavior can generate a total of 45 - 60 MB for each agent
that is running on a computer. For example, each database instance that you monitor can generate 45 - 60
MB of log data. See the "Procedure” section to learn how to adjust file size and numbers of log files to
prevent logging activity from occupying too much disk space.

Regularly prune log files other than the RAS1 log files in the logs directory. Unlike the RAS1 log files
that are pruned automatically, other log types can grow indefinitely, for example, the logs in
that include a process ID number (PID).

Use collector trace logs as an additional source of troubleshooting information.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of trace

logging. Use these settings only temporarily while you are troubleshooting problems. Otherwise, the logs
can occupy excessive amounts of hard disk space.

Manually setting RAS trace parameters

You can manually edit the RAS1 trace logging parameters.
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About this task

The Microsoft Hyper-V Server agent uses RAS1 tracing and generates the logs described in
The default RAS1 trace level is ERROR.

Procedure
1. Open the trace options file:
* Windows systems:
— For the 32-bit agent:install_dir\tmaitm6\HVENV
— For the 64-bit agent:install_dir\tmaitmé6_x64\HVENV

2. Edit the line that begins with KBB_RAS1= to set trace logging preferences. For example, if you want
detailed trace logging, set the Maximum Tracing option: KBB_RASI=ERROR (UNIT:khv ALL) (UNIT:kra
ALL)

3. Edit the line that begins with KBB_RAS1_LOG= to manage the generation of log files:

* MAXFILES: The total number of files that are to be kept for all startups of a specific program. When
this value is exceeded, the oldest log files are discarded. The default value is 9.

¢ LIMIT: The maximum size, in megabytes (MB) of a RAS] log file. The default value is 5.
 IBM Software Support might guide you to modify the following parameters:

— COUNT: The number of log files to keep in the rolling cycle of one program startup. The default is
3.

— PRESERVE: The number of files that are not to be reused in the rolling cycle of one program
startup. The default value is 1.

Note: The KBB_RAS1_LOG parameter also provides for the specification of the log file directory, log
file name, and the inventory control file directory and name. Do not modify these values or log
information can be lost.

4. Restart the monitoring agent so that your changes take effect.
What to do next

Monitor the size of the Togs directory. Default behavior can generate a total of 45 - 60 MB for each agent
that is running on a computer. For example, each database instance that you monitor can generate 45 - 60
MB of log data. See the "Procedure” section to learn how to adjust file size and numbers of log files to
prevent logging activity from occupying too much disk space.

Regularly prune log files other than the RAS1 log files in the Togs directory. Unlike the RAS1 log files
that are pruned automatically, other log types can grow indefinitely, for example, the logs in

that include a process ID (PID).

Use collector trace logs as an additional source of troubleshooting information.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of trace
logging. Use these settings only temporarily while you are troubleshooting problems. Otherwise, the logs
can occupy excessive amounts of hard disk space.

Dynamic modification of trace settings

You can dynamically modify the trace settings for an IBM Tivoli Monitoring component, such as, Tivoli
Enterprise Monitoring Server, Tivoli Enterprise Portal Server, most monitoring agents, and other
components. You can access these components, except for a few monitoring agents, from the tracing
utility.

Chapter 2. Trace logging 9



Dynamic modification of the trace settings is the most efficient method, because you can do it without
restarting the component. Settings take effect immediately. Modifications by this method are not
persistent.

Note: When the component is restarted, the trace settings are read again from the .env file. Dynamically
modifying these settings does not change the settings in the .env files. To modify these trace settings
permanently, modify them in the .env files.

rasi
Run this command to modify the trace settings for a Tivoli Monitoring component.

The syntax is as follows:

rasl set|1ist (UNIT|COMP: class name ANY|ALL|Detail|ERROR|Flow|INPUT|Metrics|OUTPUT|STATE)
{(UNIT|COMP: class_name ANY|ALL[Detail|ERROR|Flow|INPUT|Metrics|OUTPUT|STATE)}

You can specify more than one component class to which to apply the trace settings.

Command options

set
Turns on or off tracing depending upon the value of its parameters. If the parameter is ANY, it turns it
off. All other parameters turn on tracing based on the specified type or level.

list
Displays the default level and type of tracing that is set by default.

Parameters

The parameters that determine the component classes to which to apply the trace settings are as follows:

COMP: class_name
Modifies the trace setting for the name of the component class, as specified by class_name , for
example, COMP:KDH. The output contains trace for the specified class.

UNIT: class_name
Modifies the trace setting for any unit that starts with the specified class_name value, for example,
UNIT: kra. The output contains trace for any unit that begins with the specified filter pattern.

The parameters that determine the trace level and type are as follows:

ALL
Displays all trace levels, including every trace point defined for the component. This setting might
result in a large amount of trace, so specify other parameters to exclude unwanted trace. You might
require the ALL parameter to isolate a problem, which is the equivalent to setting "Error Detail Flow
State Input Output Metrics".

ANY
Turns off tracing.

Detail
Displays detailed information about each function.

When entered with the Tist option, the trace is tagged with Det.

ERROR
Logs internal error conditions.

When entered with the Tist option, the trace is tagged with ER. The output can also be tagged with
EVERYE+EVERYU+ER.
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Flow

Displays control flow data for each function entry and exit.

When entered with the Tist option, the trace is tagged with F1.

INPUT

Displays input data for each function.

When entered with the 1ist option, the trace is tagged with IN.

Metrics

Displays metrics on each function.

When entered with the 1ist option, the trace is tagged with ME.

OUTPUT

Displays output data for each function.

When entered with the Tist option, the trace is tagged with OUT.

State

Displays the status for each function.

When entered with the Tist option, the trace is tagged with St.

Example

If you enter rasl set (COMP:KDH ALL) (COMP:ACF1 ALL) (COMP:KDE ALL), the trace utility turns on all
levels of tracing for all the files and functions for which KDH, ACF1, and KDE are the classes.

kbbcrel.c, 400, May 29 2007, 12:54:43, 1.1, =*
kbbcrnl.c, 400, May 29 2007, 12:54:42, 1.1, =*
kdhblde.c, 400, May 29 2007, 12:59:34, 1.1, KDH
kdhOmed.c, 400, May 29 2007, 12:59:24, 1.1, KDH
kdhsrej.c, 400, May 29 2007, 13:00:06, 1.5, KDH
kdhblfh.c, 400, May 29 2007, 12:59:33, 1.1, KDH
kdhbloe.c, 400, May 29 2007, 12:59:38, 1.2, KDH
kdhslns.c, 400, May 29 2007, 13:00:08, 1.3, KDH
kbbacdl.c, 400, May 29 2007, 12:54:27, 1.2, ACFl
kbbaclc.c, 400, May 29 2007, 12:54:27, 1.4, ACF1
kbbacli.c, 400, May 29 2007, 12:54:28, 1.11, ACF1
vkdhsfcn.c, 400, May 29 2007, 13:00:11, 1.1, KDH
kdhserq.c, 400, May 29 2007, 12:59:53, 1.1, KDH
kdhblpr.c, 400, May 29 2007, 12:59:39, 1.1, KDH
kdhsgnh.c, 400, May 29 2007, 12:59:49, 1.1, KDH
kdhOuts.c, 400, May 29 2007, 12:59:23, 1.1, KDH
kdhsrsp.c, 400, May 29 2007, 13:00:13, 1.2, KDH
kdhslrp.c, 400, May 29 2007, 13:00:12, 1.1, KDH
kdhscsv.c, 400, May 29 2007, 12:59:58, 1.9, KDH
c, 400, May 29 2007, 12:56:50, 1.10, KDE

kdebbac.

Turning on tracing

To use the tracing utility, you must use a local logon credential for the computer. This tracing method
uses the IBM Tivoli Monitoring Service Console. Access the Service Console by using a web browser.

About this task

When you start the Service Console, information is displayed about the components that are currently
running on that computer. For example, these components are listed as follows:

* Tivoli Enterprise Portal Server: cnp

* Monitoring Agent for Windows OS: nt

 Tivoli Enterprise Monitoring Server: ms

Chapter 2. Trace logging
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After you log on, you can type a question mark (?) to display a list of the supported commands. Use the
rasl command to modify trace settings. If you type this command in the field provided in the Service
Console window and click Submit, the help for this command is displayed.

Procedure

1. Open a web browser and enter the URL to access the Service Console.
http://hostname:1920

where hostname is the IP address or host name of the computer on which the IBM Tivoli Monitoring
component is running.

2. Click the hyperlink associated with the component for which you want to modify its trace settings.

Note: In the previous view, if you want to modify tracing for the Tivoli Enterprise Monitoring Server,
select IBM Tivoli Monitoring Service Console under Service Point: system.your host name_ms.

3. Enter a user ID and password to access the system. This ID is any valid user that has access to the
system.

4. Enter the command to turn on the required level of trace for the specified component classes or units.

rasl set (UNIT|COMP: class_name ALL|Flow|ERROR|Detail|INPUT|Metrics|OUTPUT|STATE)
{(UNIT|COMP: class_name ALL|Flow|ERROR|Detail|INPUT|Metrics|OUTPUT|STATE)}

For example, to turn on the control flow trace for the KDE, the command is:
rasl (COMP:KDE Flow)

Turning off tracing

You can use the IBM Tivoli Monitoring Service Console to run the rasl command and dynamically turn
off tracing.

Procedure
1. Open a web browser and enter the URL to access the Service Console.
http://hostname:1920

where hostname is the IP address or host name of the computer on which the IBM Tivoli Monitoring
component is running.

2. Click the hyperlink associated with the component for which you want to modify its trace settings.

3. Enter a user ID and password to access the system. This ID is any valid user that has access to the
system.

4. Enter the command to turn off the required level of trace for the specified component classes or units.

rasl set (UNIT|COMP: class_name ANY)
{(UNIT|COMP: class_name ANY)}

For example, to turn off tracing for the kbbcrcd class of the Windows OS agent, the command is:
rasl set (UNIT:kbbcrcd ANY)

Setting trace parameters for the Tivoli Enterprise Console server

In addition to the trace information captured by IBM Tivoli Monitoring, you can also collect additional
trace information for the Tivoli Enterprise Console® components that gather event server metrics.

About this task

To collect this information, modify the .tec_diag_config file on the Tivoli Enterprise Console event
server. Use the steps in the following procedure to modify the event server trace parameters.

12 Microsoft Hyper-V Server agent Troubleshooting Guide



Procedure

1.
2.

4.

Open the $BINDIR/TME/TEC/.tec_diag_config file in an ASCII editor.

Locate the entries that configure trace logging for the agent components on the event server. Two
entries are included, one for tec_reception and one for tec_rule:

# to debug Agent Utils

tec_reception Agent_Utils error /tmp/tec_reception

SP

# to debug Agent Utils

tec_rule Agent_Utils error /tmp/tec_rule

To gather additional trace information, modify these entries to specify a trace level of trace2:

# to debug Agent Utils
tec_reception Agent_Utils  trace2 /tmp/tec_reception

SP
# to debug Agent Utils
tec_rule Agent Utils trace2 /tmp/tec_rule

In addition, modify the Highest_level entries for tec_rule and tec_reception:

tec_reception Highest_level trace2
SP
tec_rule Highest_level trace2

Chapter 2. Trace logging
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Chapter 3. Problems and workarounds

The known problems and workarounds are organized into types of problems that might occur with the
Microsoft Hyper-V Server agent, for example installation and configuration problems and workspace
problems.

Note: You can resolve some problems by ensuring that your system matches the system requirements
listed in the Prerequisites topic for the agent in the IBM Tivoli Composite Application Manager for

Microsoft Applications Information Center.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.

Installation and configuration troubleshooting

Problems can occur during installation, configuration, and uninstallation of the agent.

See [Table 3| and [Table 4 on page 16| for information about these problems and solutions.

Table 3. Problems and solutions for installation and configuration

Problem Solution
Diagnosing problems with product browse settings When you have problems with browse settings, complete
(Windows systems only). the following steps:

1. Click Start > Programs > IBM Tivoli Monitoring >
Manage Tivoli Enterprise Monitoring Services. The
Manage Tivoli Enterprise Monitoring Services
window is displayed.

2. Right-click the Windows agent and select Browse
Settings. A text window is displayed.

3. Click Save As and save the information in the text
file.

If requested, you can forward this file to IBM Software
Support for analysis.

A message similar to "Unable to find running CMS on If a message similar to "Unable to find running CMS on

CT_CMSLIST" in the log file is displayed. CT_CMSLIST" is displayed in the log file, the agent cannot
connect to the monitoring server. Confirm the following
points:

* Do multiple network interface cards (NICs) exist on
the system?

* If multiple NICs exist on the system, find out which
one is configured for the monitoring server. Ensure
that you specify the correct host name and port
settings for communication in the IBM Tivoli
Monitoring environment.
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Table 3. Problems and solutions for installation and configuration (continued)

Problem

Solution

If you upgrade the Microsoft Hyper-V Server agent for
ITCAM for Microsoft Applications from V6.2.0 or
V6.2.0.1 to V6.2.2, the IBM Systems Director
Configuration window does not open.

After the agent is installed, configure the agent by

completing the following steps:

1. Select Start > Program Files > IBM Tivoli
Monitoring > Manage Tivoli Enterprise Monitoring
Services. The Manage Tivoli Enterprise Monitoring
Services window opens.

2. Right-click Monitoring Agent for Microsoft Hyper-V
Server, and select Reconfigure. The Agent Advanced
Configuration window opens.

3. Click OK. The IBM Systems Director Configuration
window opens.

4. Enter the port number and the server host name for
the IBM Systems Director.

5. Select the Authenticate using Tivoli Enterprise
Portal credentials check box, and click OK.

If you have installed a 64-bit agent for ITCAM for
Microsoft Applications, information about the agent
processes is not displayed in the Kinviewer window.

No solution is available for this problem at this time.

You have preinstalled agents of earlier versions of IBM
Tivoli Monitoring for Microsoft Applications on your
computer. When you run the ITCAM for Microsoft
Applications installation wizard to upgrade the agent to
V6.2.2, the Select Features window displays a list of all
the agent features that you can install. The installed
agents are selected by default. If you do not want to
upgrade the installed features, you cannot clear the
default selection.

Run the setup.exe file of the Windows OS agent V6.2.2
or later to install the Tivoli Enterprise Monitoring Agent
Framework. Then, upgrade the preinstalled IBM Tivoli
Monitoring for Microsoft Applications agents.

When you use the Installation Launch Pad to install a
32-bit agent on a 32-bit computer, the following message
is displayed:

The following components cannot

be installed because the

installation action failed.

IBM Tivoli Composite

Application Manager for

Microsoft Applications V6.2.3

for Windows on 64-bit AMD and

Intel systems (x64)

No action is required. You can ignore this message and
continue with the installation.

Table 4. General problems and solutions for uninstallation

Problem

Solution

The way to remove inactive managed systems (systems
whose status is OFFLINE) from the Navigator tree in the
portal is not obvious.

Use the following steps to remove, but not uninstall, an

offline managed system from the Navigator tree:

1. Click the Enterprise icon in the Navigator tree.

2. Right-click, and then click Workspace > Managed
System Status.

3. Right-click the offline managed system, and select
Clear offline entry.

To uninstall the monitoring agent, use the procedure
described in the IBM Tivoli Monitoring Installation and
Setup Guide.
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Remote deployment troubleshooting

Problems can occur with remote deployment and removal of agent software using the Agent Remote

Deploy process.

contains problems and solutions related to remote deployment.

Table 5. Remote deployment problems and solutions

Problem

Solution

KDY1008E error when using remote operations to
remove the last instance of the agent.

There are two windows when removing an agent when
it is the last instance. The first asks to remove the
instance. The second asks to uninstall. If you say Yes to
the first and No to the second for a single-instance agent,
you always get the KDY1008E error. The workaround is
to always say Yes in the second window to uninstall.

The removal of a monitoring agent fails when you use
the remote removal process in the Tivoli Enterprise
Portal desktop or browser.

This problem might occur when you attempt the remote
removal process immediately after you restart the Tivoli
Enterprise Monitoring Server. You must allow time for
the monitoring agent to refresh its connection with the
Tivoli Enterprise Monitoring Server before you begin the
remote removal process.

What are the remote deploy CLI parameters for the
agent?

The IBM Tivoli Monitoring command line is documented
in the IBM Tivoli Monitoring Installation and Setup Guide.
Also, see the “Agent installation and configuration”
chapter in the IBM Tivoli Composite Application Manager
for Microsoft Applications: Microsoft Hyper-V Server Agent
Installation and Configuration Guide.

For the section name, CTIRA_HOSTNAME, the configuration
parameter for remote deploy is as follows:
section.configParameter

For remote configuration of an active node where -m
managed system name is that of the Microsoft Cluster
Server agent the command line is as follows: tacmd
configureSystem -m CTIRA_HOSTNAME:Q5 -p
MSCS.CTIRA_HOSTNAME="new hostname"
MSCS.CTIRA_HIST_DIR="new directory name"

When you remotely deploy the Hyper-V Server agent
from the Tivoli Enterprise Portal, on the Agent tab of the
New Managed System Configuration window, if you
specify the account in the user@domain.com format (for
example, administrator@itmagents.com), the following
error message is displayed: KDY1008E: The agent action
SETCONFIG Failed with a return code of 10 for the
product code HV. The command C:\IBM\ITM\TMAITM6_ X64\
kdy xa.exe ?p ITMHV1:HV ?pc hv produced the
following error text: Error line (1642): unable to
set user to run service as. The specified return
code was received from the two way translator.

There are two possible solutions to this problem.

Solution 1: Use the ddomain\user format to specify the
account.

Solution 2: Use the Use local system account option to
remotely deploy the agent.
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Table 5. Remote deployment problems and solutions (continued)

Problem

Solution

Remote installation (CLI and GUI) of Microsoft Hyper-V
Server agent fails on IPv6 network. The agent gets
installed on a computer but fails to configure and start.
The agent appears offline on the Tivoli Enterprise Portal.
Note: This problem occurs with IBM Tivoli Monitoring
V6.3, Fix Pack 1, or earlier.

Reconfigure the Microsoft Hyper-V Server agent by
completing the following steps:.

1. Open the Manage Tivoli Enterprise Monitoring
Services window.

2. Right-click Microsoft Hyper-V Server agent that you
want to configure with the IPv6 network and then,
click Advanced.

3. Click Edit Variable. Following message appears: The
service must be stopped before editing
variables. Do you want to stop the service now?

4. Click Yes. The Edit Variable window appears.

5. Click Add.

6. Enter the following details in the respective fields:

* Variable Name: CT_CMSLIST
¢ Variable Value: IP6.PIPE:ITM-IPV6;IP6.PIPE:<IP
of the TEMS machine>. For example:
IP6.PIPE:ITM-IPV6;IP6.PIPE:
FE80::215:5DFF:FE44:4012
7. Click Ok.

8. Right-click Microsoft Hyper-V Server agent and then
click Start.

Agent troubleshooting

A problem can occur with the agent after it has been installed.

contains problems and solutions that can occur with the agent after it is installed.

Table 6. Agent problems and solutions

Problem

Solution

Log data accumulates too rapidly.

Check the RAS trace option settings, which are described
in [“Setting RAS trace parameters by using the GUI” on|

[page 7, The trace option settings that you can set on the

KBB_RAS1= and KDC_DEBUG= lines potentially generate large
amounts of data.

Rollup Error messages in the agent log file.

Rollup error messages occur when a base WMI query

fails and no source data is available to "roll up." Check
the log for the initial WMI error to resolve. The rollup
error disappears when the initial problem is corrected.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

WMI Error 0x80041006 There was not enough memory
for the operation.

WMIPrsve.exe memory increases to 135MB before
recycling.

The issue is a known issue with the Microsoft WMI
Cluster Association class provider, which IBM Software
Support is working with Microsoft to resolve. Until a fix
is available, the following workaround has been
provided from Microsoft. It sets the Cluster WMI
provider to run in a standalone WMlIprvse.exe host. The
script also lowers the cache timeout to 30 seconds. So, if
the cluster provider is idle for more than 30 seconds, the
hosting WMIprvse.exe process is recycled, minimizing
the effect of the leak.

1. Copy and paste the following into a file and save
with a .vbs extension (for example, wmi_fix.vbs). If
the comments (lines beginning with ') cause
problems, remove them.

'===[ Script start ]=====================

Set objLocator = CreateObject
("wbemscripting.swbemlocator")

set WMIServices = objLocator.ConnectServer
(".","Y‘OOt")

set cachecontrol = WMIServices.Get
("_ObjectProviderCacheControl=@")
cachecontrol.ClearAfter =
"00000000000025.000000: 000"
cachecontrol.Put_ set WMIServices =
objLocator.ConnectServer(".", " "root\MSCTuster")
set ClusProvReg = WMIServices.Get
("_Win32Provider.Name=
""MS_CLUSTER_PROVIDER""")
ClusProvReg.HostingModel =
"NetworkServicehost:ClusterProvider"
CTusProvReg.Put_

'===[ Script stop ]==================

2. Run it on each computer where the agent is running.

3. Restart the system.

If the problem persists (which typically happens if there
are multiple objects querying WMI, such as a second
agent), try reducing the cache time from 25 seconds to a
lower value.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

Agent log files are not in the CANDLEHOME/tmaitm6/10gs
directory.

If you reset the logging level to "none," and then turn
logging back on by setting the logging level to something
other than "none," the Manage Tivoli Enterprise
Monitoring Services utility automatically resets the log
directory to CANDLEHOME/10gs.

Logging is not affected. Older logs remain in
CANDLEHOME/TMAITM6/10gs. New logs are placed in
CANDLEHOME/10gs.

You can manually edit the ENV file using Manage Tivoli
Enterprise Monitoring Services:

1. Right-click the agent. Select Advanced > Edit ENV
file.

2. Adjust the line prefixed by KBB_RAS1_LOG to the
line in the example. You must substitute ITM_HOME
with the path to your IBM Tivoli Monitoring
installation directory.

-OR-

You can also add "\TMAITM6" before all "\logs" in the
KBB_RAS1_LOG line. Example: KBB_RAS1_LOG=ITM_HOME\
TMAITM6\10gs\

$(computername) g5_kg5agent_$(sysutcstart)-.log
INVENTORY=ITM_HOME\TMAITM6\10gs\

$ (computername) _g5_kg5agent.inv COUNT=03 LIMIT=5
PRESERVE=1 MAXFILES=9

If you set the Notes attribute to have multiline text when
setting the configuration for a virtual machine, the data
row for that virtual machine is not visible in the Virtual
Machine attribute group.

Start the Hyper-V Manager and use the following steps
to change the Notes attribute value:

1. In the Hyper-V Manager, select the Hyper-V host
name to open the Virtual Machine list for the selected
Hyper-V host name.

2. Right-click the required virtual machine, and click
Settings.

3. Click Management > Name.

4. Enter only a single line of text in the Notes window.

The Time Generated attribute in the Event Log attribute
group does not show time according to the local time
zone.

The Time Generated attribute displays the Greenwich
Median Time (GMT). Based on the time difference in
GMT and your local time, you can convert the time
displayed by the Time Generated attribute to your local
time.

You can also see the value for the Timestamp attribute to
see the local time at which the event is generated.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

A configured and running instance of the monitoring
agent is not displayed in the Tivoli Enterprise Portal, but
other instances of the monitoring agent on the same
system are displayed in the portal.

IBM Tivoli Monitoring products use Remote Procedure
Call (RPC) to define and control product behavior. RPC
is the mechanism that a client process uses to make a
subroutine call (such as GetTimeOfDay or
ShutdownServer) to a server process somewhere in the
network. Tivoli processes can be configured to use
TCP/UDP, TCP/IP, SNA, and SSL as the protocol (or
delivery mechanism) for RPCs that you want.

IP.PIPE is the name given to Tivoli TCP/IP protocol for
RPCs. The RPCs are socket-based operations that use
TCP/IP ports to form socket addresses. IPPIPE
implements virtual sockets and multiplexes all virtual
socket traffic across a single physical TCP/IP port
(visible from the netstat command).

A Tivoli process derives the physical port for IP.PIPE
communications based on the configured, well-known
port for the hub Tivoli Enterprise Monitoring Server.
(This well-known port or BASE_PORT is configured by
using the PORT:" keyword on the KDC_FAMILIES /
KDE_TRANSPORT environment variable and defaults to
'1918'".)

The physical port allocation method is defined as
(BASE_PORT + 4096*N), where N=0 for a Tivoli
Enterprise Monitoring Server process and N=({1, 2, ..., 15}
for another type of monitoring server process. Two
architectural limits result as a consequence of the
physical port allocation method:

* No more than one Tivoli Enterprise Monitoring Server
reporting to a specific Tivoli Enterprise Monitoring
Server hub can be active on a system image.

* No more than 15 IPPIPE processes can be active on a
single system image.

A single system image can support any number of Tivoli
Enterprise Monitoring Server processes (address spaces)
if each Tivoli Enterprise Monitoring Server on that image
reports to a different hub. By definition, one Tivoli
Enterprise Monitoring Server hub is available per
monitoring enterprise, so this architecture limit has been
reduced to one Tivoli Enterprise Monitoring Server per
system image.

No more than 15 IPPIPE processes or address spaces can
be active on a single system image. With the first limit
expressed earlier, this second limitation refers specifically
to Tivoli Enterprise Monitoring Agent processes: no more
than 15 agents per system image.

Continued on next row.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

Continued from previous row.

This limitation can be circumvented (at current
maintenance levels, IBM Tivoli Monitoring V6.1, Fix Pack
4 and later) if the Tivoli Enterprise Monitoring Agent
process is configured to use the EPHEMERAL IP.PIPE
process. (This process is IPPIPE configured with the
'EPHEMERAL:Y' keyword in the KDC_FAMILIES /
KDE_TRANSPORT environment variable). The number of
ephemeral IP.PIPE connections per system image has no
limitation. If ephemeral endpoints are used, the
Warehouse Proxy agent is accessible from the Tivoli
Enterprise Monitoring Server associated with the agents
using ephemeral connections either by running the
Warehouse Proxy agent on the same computer or by
using the Firewall Gateway feature. (The Firewall
Gateway feature relays the Warehouse Proxy agent
connection from the Tivoli Enterprise Monitoring Server
computer to the Warehouse Proxy agent computer if the
Warehouse Proxy agent cannot coexist on the same
computer.)

If the Microsoft Hyper-V Server agent is installed on
Windows Server 2008, Service Pack 2, a memory leak is
observed.

Install the hot fix for Windows Server 2008, Service Pack
2 from [Microsoft Support] (http://
support.microsoft.com/kb/970838).

On the Windows Server 2008 operating system, the Tivoli
Enterprise Portal displays Value_Exceeds_Maximum for the
GPA Pages attribute of the Hyper-V Hypervisor Partition
attribute group.

There is no solution to this problem.

For the following workspaces, data is displayed in the
plot chart view only for the first instance and not for all
instances:

* Virtual Network Adapter

* Legacy Network Adapter

* Virtual Switch Port

» IDE Controller

* Root Virtual Processor Load

* VM Virtual Processor Load

* Hyper-V Logical Processor Load

Use the following steps to change the properties of the
plot chart view to view the graph for all instances:

1. Right-click the plot chart view, and click Properties.
The Properties window opens.

2. In the left pane, expand Views > Plot Chart Views,
and click Bytes. The Preview pane opens.

3. Click the Style tab. The Style pane opens.
4. Click the plot chart.

5. In the Select Plot Points area, click Attribute(s)
across multiple rows.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

On Windows Server 2008, Service Pack 2 and Microsoft
Hyper-V Server 2008 operating systems, the Tivoli
Enterprise Portal displays an incorrect value randomly
and sometimes displays VALUE_EXCEEDS_MAXIMUM
for the following attributes:

Hyper-V Hypervisor Logical Processor attribute group

Hardware Interrupts Per Sec

Inter Processor Interrupts Per Sec
Inter Processor Interrupts Sent Per Sec
Context Switches Per Sec

Scheduler Interrupts Per Sec

Timer Interrupts Per Sec

Total Interrupts Per Sec

Hyper-V Hypervisor Root Virtual Processor attribute
group

Virtual Processor Hypercalls Per Sec
GPA Space Hypercall Per Sec

Page Fault Intercepts Per Sec

Guest Page Table Maps Per Sec
Virtual MMU Hypercalls Per Sec
Virtual Processor Hypercalls Per Sec
Total Messages Per Sec

Hyper-V Hypervisor Root Virtual Processor More
attribute group

— Synthetic Interrupts Per Sec
Synthetic Interrupts Hypercalls Per Sec
Page Table Write Intercepts Per Sec
Reflected Guest Page Faults Per Sec
Page Table Resets Per Sec

Local Flushed GVA Ranges Per Sec
Large Page TLB Fills Per Sec
Global GVA Range Flushes Per Sec
Address Space Switches Per Sec
APIC EOI Accesses Per Sec

APIC IPIs Sent Per Sec

APIC Self IPIs Sent Per Sec

Hyper—V Hypervisor Virtual Processor attribute group

Virtual Processor Hypercalls Per Sec
GPA Space Hypercall Per Sec

Page Fault Intercepts Per Sec

Guest Page Table Maps Per Sec
Virtual MMU Hypercalls Per Sec
Virtual Processor Hypercalls Per Sec
Total Messages Per Sec

(continued in the next row)

Install Windows Server 2008 R2.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

(continued from previous row)

On Windows Server 2008, Service Pack 2 and Microsoft
Hyper-V Server 2008 operating systems, the Tivoli
Enterprise Portal displays an incorrect value randomly
and some times displays VALUE_EXCEEDS_MAXIMUM
for the following attributes:
* Hyper-V Hypervisor Virtual Processor More attribute

group

— Synthetic Interrupts Per Sec

— Synthetic Interrupts Hypercalls Per Sec

— Page Table Write Intercepts Per Sec

— Reflected Guest Page Faults Per Sec

— Page Table Resets Per Sec

— Local Flushed GVA Ranges Per Sec

— Large Page TLB Fills Per Sec

- Global GVA Range Flushes Per Sec

— Address Space Switches Per Sec

— APIC EOI Accesses Per Sec

— APIC IPIs Sent Per Sec

— APIC Self IPIs Sent Per Sec

Install Windows Server 2008 R2.

On the Tivoli Enterprise Portal, the hover help for the
Full Name attribute in the Availability attribute group
displays the following text for both services and
processes:

The full name of the process including the path

This description is valid only when the attribute name
refers to a process. The description is not valid for a
service because a service name does not display a path.

This behavior is expected. The Tivoli Enterprise Portal is
designed to display the same hover help for the Full
name attribute, regardless of whether the attribute is a
process or a service.

A problem can arise when trying to make local changes
using Manage Tivoli Enterprise Monitoring Services that
required the agent to be stopped while the agent cluster
resource controlling the agent is online.

Some local changes might require the agent to be taken
offline. In these cases, you receive a warning prompt that
states the agent must be taken offline to make these
changes. If the cluster resource is online the cluster
server attempts to bring the agent back online, which
interferes with this operation.

Take the agent cluster resource offline during operations
requiring the agent to be offline. When the operations are
complete, bring the agent cluster resource back online.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

You have configured the monitoring agent version 6.3 on
the Tivoli Enterprise Monitoring Server by using the
self-describing agent feature. You are using IBM Tivoli
Monitoring version 6.2.3 or version 6.2.3 Fix Pack 1. On
the Tivoli Enterprise Portal, if you open a situation by
using the Situation Editor and view the advance options
for the situation, you can see <none selected> in the
Display Item window.

Recycle the Tivoli Enterprise Portal Server.

Complete the following steps to recycle the Tivoli
Enterprise Portal Server on Windows systems:

1. On the computer where the Tivoli Enterprise Portal
Server is installed, click Start > Programs > Manage
Tivoli Enterprise Monitoring Services.

2. Right-click the Tivoli Enterprise Portal Server service
and click Recycle.

To recycle the Tivoli Enterprise Portal Server on UNIX
systems, use the following commands from the bin
directory of /opt/IBM/ITM (or where you have installed
IBM Tivoli Monitoring) in the order shown below:

e ./itmcmd agent stop cq

e ./itmcmd agent start cq

You cannot log on to the IBM Systems Director version
6.3, or later by using the IBM Systems Director crosslink
in the Virtual Machine workspace.

This problem occurs when the following conditions exist:
* You have installed the Microsoft Hyper-V Server agent
V6.3.1 and configured IBM Systems Director V6.3 on

your computer.

* You have configured the Authenticate using Tivoli
Enterprise Portal credentials parameter as YES by
using the monitoring agent.

There is no solution to this problem.

When you remotely install the monitoring agent, you
cannot see the options to perform remote operations in
the physical and logical views of a navigator item on the
Tivoli Enterprise Portal. When you connect the Windows
OS agent and the monitoring agent for the first time to
Tivoli Enterprise Monitoring Server, the options to
perform remote operations are available in the physical
view. However, when you assign the logical view to the
managed system and update the logical view, the options
to perform remote operations disappear from the logical
and physical views of a navigator item.

Complete one of the following tasks to resolve this
problem:

* Use the command line interface to perform remote
operations.

* Complete the following steps to resolve this problem:
1. Stop the monitoring agent.

2. Remove the entries for the agent from the logical
and physical views and update the navigator
items.

3. Start the monitoring agent.

* Restart Tivoli Enterprise Monitoring Agent or IBM
Tivoli Monitoring environment.

You have enabled the self-describing agent feature for
the Tivoli Enterprise Portal Server. When you upgrade
the Microsoft Hyper-V Server agent support for Tivoli
Enterprise Portal Server to version 6.3, the support files
are not automatically upgraded to version 6.3.

Upgrade the monitoring agent support manually to
version 6.3 of Tivoli Enterprise Portal Server.
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Workspace troubleshooting

Problems can occur with general workspaces and agent-specific workspaces.

contains problems and solutions related to workspaces.

Table 7. Workspace problems and solutions

Problem

Solution

The process application components are available, but
the Availability status shows PROCESS_DATA_NOT_
AVAILABLE.

This problem occurs because the PerfProc performance
object is disabled. When this condition exists, IBM Tivoli
Monitoring cannot collect performance data for this
process. Use the following steps to confirm that this
problem exists and to resolve it:

1. In the Windows Start menu, click Run.

2. Type perfmon.exe in the Open field of the Run
window. The Performance window is displayed.

3. Click the plus sign (+) in the toolbar. The Add
Counters window is displayed.

4. Look for Process in the Performance object menu.

5. Complete one of the following actions:
* If you see Process in the menu, the PerfProc

performance object is enabled and the problem is

coming from a different source. You might need to
contact IBM Software Support.

* If you do not see Process in the menu, use the
Microsoft utility from the [Microsoft.com Operations|
to enable the PerfProc performance object.

The Process performance object becomes visible in
the Performance object menu of the Add Counters
windows, and IBM Tivoli Monitoring is able to
detect Availability data.

6. Restart the monitoring agent.

At the end of the historical view, you see the following
error: KFWITM220E Request failed during execution.

Ensure that you configure History. In the Historical
Configuration view, ensure that data collection is
configured and started. It takes two collection intervals
for the data to first appear. If you choose 5 minutes, the
first point of data shows up after 5 minutes. On the Tivoli
Enterprise Portal Server: Configuration

1. Select Edit > History Configuration > Select A
Product.

Select MS Cluster Server.
Select the Groups you want to monitor.

Set the Configuration Controls to the levels you want.

ok w0bd

Click Configure Groups to complete the
configuration.
To start the history collection:

1. Select the Groups you want to monitor (repeat step 3
above).

2. Click Start Collection.
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Table 7. Workspace problems and solutions (continued)

Problem

Solution

Event Log workspace events are unfiltered, are not
collected more than every 60 seconds, and are removed
from the Event Log Views after 1 hour of being received.

All events currently in the Application Event Log are sent
to the Tivoli Enterprise Monitoring Server when the agent
starts. Environment variables that control the behavior of
the Event Log Workspace are stored in the agent ENV file
on the Tivoli Enterprise Monitoring Agent where the
agent is running. These variables are stored:

CDP_DP_CACHE_TTL
This value is the minimum number of seconds
before data (for a particular table) is collected
again. By default this variable is present in the
ENV file and the value is set to 60.

CDP_NT_EVENT_LOG_GET_ALL_ENTRIES_FIRST TIME
This variable determines whether the agent
sends all events currently in the Application
Event Log to the Tivoli Enterprise Monitoring
Server when the agent starts. Legal values are
YES and NO. By default this variable is present
in the ENV file and the value is set to NO.

CDP_NT_EVENT_LOG_CACHE_TIMEOUT
This variable determines how long in seconds
that events are displayed in the Tivoli Enterprise
Monitoring Server Event Log Views. By default,
this variable is not present in the ENV file. A
default value of 3600 (1 Hour) is used unless
overridden by the presence of this variable in the
agent ENV file. The minimum legal value is 300.
To view or edit the agent ENV file on the Tivoli Enterprise
Monitoring agent where the agent is installed, use
Manage Tivoli Enterprise Monitoring Services to select
the agent. Right-click and select Advanced - Edit ENV
File. The agent must be restarted to implement changes.

The name of the attribute does not display in a bar chart
or graph view.

When a chart or graph view that includes the attribute is
scaled to a small size, a blank space is displayed instead
of a truncated name. To see the name of the attribute,
expand the view of the chart until sufficient space is
available to display all characters of the attribute name.

At the end of each view, you see the following Historical
workspace KFWITM220E error: Request failed during
execution.

Ensure that you configure all groups that supply data to
the view. In the Historical Configuration view, ensure that
data collection is started for all groups that supply data
to the view.
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Table 7. Workspace problems and solutions (continued)

Problem

Solution

You start collection of historical data but the data cannot
be seen.

Use the following managing options for historical data
collection:

* Basic historical data collection populates the Warehouse
with raw data. This type of data collection is turned off
by default. For information about managing this
feature including how to set the interval at which data
is collected, see Managing historical data in the IBM
Tivoli Monitoring Administrator’s Guide. By setting a
more frequent interval for data collection, you reduce
the load on the system incurred every time data is
uploaded.

* Use the Summarization and Pruning agent to collect
specific amounts and types of historical data. Historical
data is not displayed until the Summarization and
Pruning monitoring agent begins collecting the data.
By default, this agent begins collection at 2 a.m. daily.
At that point, data is visible in the workspace view. For
information about how to modify the default collection
settings, see Managing historical data in the IBM Tivoli
Monitoring Administrator’s Guide.

Historical data collection is unavailable because of
incorrect queries in the Tivoli Enterprise Portal.

The Sort By, Group By, and First/Last functions column
are not compatible with the historical data collection
feature. Use of these advanced functions makes a query
ineligible for historical data collection.

Even if data collection has started, you cannot use the
time span feature if the query for the chart or table
includes column functions or advanced query options
(Sort By, Group By, First / Last).

To ensure support of historical data collection, do not use
the Sort By, Group By, or First/Last functions in your
queries.

For information about the historical data collection
function, See Managing historical data in the IBM Tivoli
Monitoring Administrator’s Guide or the Tivoli Enterprise
Portal online help .

When you use a long process name in the situation, the
process name is truncated.

Truncation of process or service names for situations in
the Availability table in the portal display is the expected
behavior. The maximum name length is 100 bytes.

Regular (non-historical) monitoring data fails to be
displayed.

Check the formation of the queries you use to gather
data. For example, look for invalid SQL statements.
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Table 7. Workspace problems and solutions (continued)

Problem

Solution

Historical data is unavailable.

* Local time differences for the Tivoli Enterprise Portal,
Tivoli Enterprise Monitoring Server, and the
monitoring agent can affect history. History is stored at
the monitoring agent.

* Check that a directory is present on the shared disk
and that all the agents are configured to use that
directory.

* Check for OpenHistoryFiles errors in the agent log to
see if history files are created.

* If no shared disk is provided for the agent, history
must be stored at the Tivoli Enterprise Monitoring
Server. Ensure that history is set up to be stored at
Tivoli Enterprise Monitoring Server.

* If you have a hub and a remote Tivoli Enterprise
Monitoring Server, start historical data collection
correctly on that Tivoli Enterprise Monitoring Server.

Navigator items and workspace titles are labeled with
internal names such as Kxx:KXX0000 instead of the
correct names (such as Disk), where XX and xx represent
the two-character agent code.

Ensure that application support has been added on the
monitoring server, portal server, and portal client.

For more information about installing application
support, see Installing and enabling application support in
the IBM Tivoli Monitoring Installation and Setup Guide.

The Event Log workspace events are removed from the
Event Log view after every 100 data rows.

Environment variables that control the behavior of the
Event Log workspace are stored in the agent ENV file on
the Tivoli Enterprise Monitoring Agent where the agent is
running. The CDP_PURE_EVENT_CACHE_SIZE variable
in the agent ENV file controls the number of data rows
that are cached. By default the value is set to 100.

You can modify the value for the
CDP_PURE_EVENT_CACHE_SIZE variable to include the
number of data rows that you require.

To view or edit the agent ENV file, on the Tivoli Enterprise
Monitoring agent where the agent is installed, use
Manage Tivoli Enterprise Monitoring Services to select
the agent. Right-click the agent, click Advanced , and
click Edit ENV File. Restart the agent to implement the
changes.

On the Tivoli Enterprise Portal, in the Event Log
workspace, an event message gets truncated if the
length of the message is more than 2000 characters.

There is no solution to this problem.
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Situation troubleshooting

Problems can occur with situations and situation configuration.

contains problems and solutions for situations.

Table 8. Situation problems and solutions

Problem

Solution

Monitoring activity requires too much disk space.

Check the RAS trace logging settings that are described
in [“Setting RAS trace parameters by using the GUI” on|
[page 7 For example, trace logs grow rapidly when you
apply the ALL logging option.

Monitoring activity requires too many system resources.

See the “Disk capacity planning for historical data” topic
in the IBM Tivoli Composite Application Manager for
Microsoft Applications: Microsoft Hyper-V Server Agent
Installation and Configuration Guide that describes the
performance impact of specific attribute groups. If
possible, decrease your use of the attribute groups that
require greater system resources.

You want to change the appearance of situations when
they are displayed in the navigation tree.

1. Right-click an item in the navigation tree.

2. (lick Situations in the menu. The Situation Editor
window is displayed.

3. Select the situation that you want to modify.

4. Use the State menu to set the status and appearance
of the Situation when it triggers.

Note: The State setting is not related to severity
settings in the Tivoli Enterprise Console.
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Table 8. Situation problems and solutions (continued)

Problem

Solution

No event notification is given when a monitoring agent
is down.

By default, agent status is available in the Enterprise
System Status workspace. However, by default, an event
is not generated for a status change. The following
situation definition causes a situation to fire when any
Microsoft Cluster Server agent being monitored goes
offline. To enable the Agent Down situation, complete
the following steps:

* Click Edit > Situation Editor > All Managed Systems
> MS_Offline.

* Right-click Create another.
* Complete the following:
— Name: KQ5_MSCS_Agent_Down

— Description: The agent is not running. This can
be either an agent or cluster failure.

» Click OK.

* Click Add conditions

* Click Product.

» Click OK.

¢ For Product, enter ==Q5.

* Click OK.

* Right-click Any managed system] > Situations.
* Click Set Situation filter criteria...

* Select Eligible for association and Associated with
Monitored Application.

* Select All Managed Systems >
KQ5_MSCS_Agent_Down.

* Right-click KQ5_MSCS_Agent_Down > Associate.
* Click Apply and then click OK.

When a situation is triggered in the Event Log attribute
group, it remains in the Situation Event Console as long
as the event ID entry is present in the Event Log
workspace. When this event ID entry is removed from
the Event Log workspace on the Tivoli Enterprise Portal,
the situation is also cleared even if the actual problem
that caused the event is not resolved, and the event ID
entry is also present in the Windows Event Viewer.

A timeout occurs on the cache of events for the NT Event
Log group. Increase the cache time of Event Log
collection to meet your requirements by adding the
following variable and timeout value to the KpcENV file
for the agent (where pc is the two-letter product code):
CDP_NT_EVENT_LOG_CACHE_TIMEOUT=3600

This variable determines how long events from the NT
Event Log are kept.

If the Expert Advice for a situation contains a hyperlink
to an external website (for example, a Microsoft TechNet
website) and you click the hyperlink, the website opens
in an external window. However, the external window
stops responding.

The external window responds after you close the
Preview window and Situation Editor window.

The situation for a specific agent is not visible in the
Tivoli Enterprise Portal.

Open the Situation Editor. Access the All managed
servers view. If the situation is not displayed, confirm
that the monitoring server has been seeded for the agent.
If not, seed the server, as described in the IBM Tivoli
Monitoring Installation and Setup Guide.

The monitoring interval is too long.

Access the Situation Editor view for the situation that
you want to modify. Check the Sampling interval area in
the Formula tab. Adjust the time interval as required.
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Table 8. Situation problems and solutions (continued)

Problem

Solution

The situation did not activate at startup.

Manually recycle the situation as follows:

1. Right-click the situation and select Stop Situation.
2. Right-click the situation and select Start Situation.
Note: You can permanently avoid this problem by

selecting the Run at Startup check box of the Situation
Editor view for a specific situation.

The situation is not displayed.

Click the Action tab and check whether the situation has
an automated corrective action. This action can occur
directly or through a policy. The situation might be
resolving so quickly that you do not see the event or the
update in the graphical user interface.

An Alert event did not occur even though the predicate
was correctly specified.

Check the logs, reports, and workspaces.

A situation fires on an unexpected managed object.

Confirm that you distributed and started the situation on
the correct managed system.

The product did not distribute the situation to a
managed system.

Click the Distribution tab and check the distribution
settings for the situation.
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Table 8. Situation problems and solutions (continued)

Problem

Solution

The situation does not fire.

This problem can be caused when incorrect predicates
are present in the formula that defines the situation. For
example, the managed object shows a state that normally
triggers a monitoring event, but the situation is not true
because the wrong attribute is specified in the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon in the Formula area. The Show
formula window is displayed.

a. Confirm the following details in the Formula area
of the window:

* The attributes that you intend to monitor are
specified in the formula.

* The situations that you intend to monitor are
specified in the formula.

* The logical operators in the formula match your
monitoring goal.

* The numeric values in the formula match your
monitoring goal.

b. (Optional) Select the Show detailed formula
check box to see the original names of attributes
in the application or operating system that you
are monitoring.

c. Click OK to dismiss the Show formula window.

2. (Optional) In the Formula area of the Formula tab,
temporarily assign numeric values that immediately
trigger a monitoring event. The triggering of the
event confirms that other predicates in the formula
are valid.

Note: After you complete this test, you must restore
the numeric values to valid levels so that you do not
generate excessive monitoring data based on your
temporary settings.

For additional information about situations that do not
fire, see Situations are not firing in the IBM Tivoli
Monitoring Troubleshooting Guide.

Situation events are not displayed in the Events Console
view of the workspace.

Associate the situation with a Navigator item.

Note: The situation does not need to be displayed in the
workspace. It is sufficient that the situation is associated
with any Navigator item.

You do not have access to a situation.

Note: You must have administrator privileges to

complete these steps.

1. Click Edit > Administer Users to access the
Administer Users window.

2. In the Users area, select the user whose privileges
you want to modify.

3. In the Permissions tab, Applications tab, and
Navigator Views tab, select the permissions or
privileges that correspond to the user role.

4. Click OK.
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Table 8. Situation problems and solutions (continued)

Problem Solution

A managed system seems to be offline. 1. Select Physical View and click the Enterprise Level of
the navigator tree.

2. Click View > Workspace > Managed System Status
to see a list of managed systems and their status.

3. If a system is offline, check network connectivity and
the status of the specific system or application.

When using Manage Tivoli Enterprise Monitoring Some local changes might require the agent to be taken
Services, a problem arises when trying to make local offline. In these cases, you receive a warning prompt that
changes that require the agent to be stopped while the states the agent must be taken offline to perform this
agent cluster resource controlling the agent is online. operation. If the cluster resource is online the cluster

server attempts to bring the agent back online, which
interferes with this operation. Take the agent cluster
resource offline while performing operations requiring
the agent to be offline. When the operations are
complete, bring the agent cluster resource back online.

Take Action commands troubleshooting

Problems can occur with Take Action commands.

contains problems and solutions that can occur with Take Action commands.

When each Take Action command runs, it generates a log file listed in [Table 2 on page 4

Table 9. Take Action commands problems and solutions

Problem Solution

Take Action commands often require several minutes to | Allow several minutes. If you do not see a message

complete. advising you of completion, try to run the command
manually.
Situations fail to trigger Take Action commands. Attempt to manually run the Take Action command in

the Tivoli Enterprise Portal. If the Take Action command
works, look for configuration problems in the situation.
See [“Situation troubleshooting” on page 30.If the Take
Action command fails, for general information about
troubleshooting Take Action commands, see the IBM
Tivoli Monitoring Troubleshooting Guide.

Tivoli Common Reporting troubleshooting

You can troubleshoot problems that occur with the Tivoli Common Reporting predefined reports for the
Microsoft Hyper-V Server agent.

[Table 10 on page 35| contains problems and solutions that can occur with the Tivoli Common Reporting
predefined reports for the agent. For information about troubleshooting for the Tivoli Common Reporting
tool, see [TroubleshootingTivoli Common Reporting| (http:/ /pic.dhe.ibm.com/infocenter/tivihelp /v3r1/
topic/com.ibm.psc.doc_1.1.0.1/tshoot/tcr_c_tshoot.html).
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Table 10. Tivoli Common Reporting for Microsoft Hyper-V Server agent problems and solutions

Problem

Solution

When you simultaneously query two tables in the Query
Studio interface, no data is displayed. However, when
you query the two tables separately, data is displayed.

This problem occurs when a relationship between the
tables is not defined. To resolve this problem, ensure that
all the ad hoc queries have at least one identifier.

When you create an ad hoc query by dragging some
columns in the Query Studio interface, the following
error message is displayed:

RQP-DEF-0177 An error occurred while performing

operation 'sqlPrepareWithOptions'
status='-232".

This is an SQL error related to arithmetic flow. This error
is generated because the average or the sum for certain
columns is more than the threshold size that is defined
in the database. To resolve this error, use the limited
columns and add a standard timestamp while creating
an ad hoc query.

If a view or a table for the selected summarization type

does not exist in the database for a report, the report

does not open and the following error message is

displayed:

RQP-DEF-0177 An error occurred while performing
operation 'sqlPrepareWithOptions'

status='-56".

To resolve this problem, complete the following tasks:

* Verify that the summarization and pruning agent is
working correctly.

* Generate data for all the summarization types.

* Verify that the warehouse is collecting historical data.

When you run a report, the report is not displayed in the

correct format and the following error message is

displayed:

RQP-DEF-0177 An error occurred while performing
operation 'sqlPrepareWithOptions'

status="'-16".

This problem occurs due to incorrect data source. To
resolve this problem, complete the following tasks:

* Verify that the datasource configuration parameters are
configured correctly.

* Verify that the specified values for the parameters of
the summarization and pruning agent such as
database URL, driver user, and password match with
the values of these parameters on the database.

If data is not available in the database for the selected
parameters, the following error message is displayed
after querying these parameters:

Empty data set No data returned by query.
Try another set of parameters.

To resolve this error, complete the following tasks:

* Configure the summarization and pruning agent and
verify that it is working correctly.

* Generate data for all the summarization types in the
database.

Reports are not generated correctly in the Microsoft Excel
format.

There are some limitations to generate reports in the
Microsoft Excel format. To view these limitations, see the
[IBM Cognos Business Intelligence Information Center|
(http:/ /pic.dhe.ibm.com/infocenter/cx/v10r1m0/topic/
com.ibm.swg.ba.cognos.ug_cr_rptstd.10.1.0.doc/
c_excel_limitations.html)

When you view a report spanning multiple pages in the
PDF format, the report parameters section is displayed at
the top of each page.

No solution is available for this problem at this time.

Charts are not displayed correctly in Microsoft Excel
2007.

No solution is available for this problem at this time.
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Table 10. Tivoli Common Reporting for Microsoft Hyper-V Server agent problems and solutions (continued)

Problem

Solution

Labels for some charts are displayed in the HTML
output, but are not displayed in the PDF output.

The font size is rendered differently in the HTML and
the PDF output. In the PDF output, some fonts are not
displayed because of the large font size. To resolve this
issue, reduce the font size by completing the following
steps:

1. Open the report in Report Studio.

2. Click the chart.

3. In the chart properties, select Font.

4

. Modify the font properties, such as family, size,
weight, and style.
5. Save the settings, and run the report in the PDF
format.

Images are not displayed correctly when you run the
reports in the Tivoli Common Reporting Server V3.1.

To view images, extract the report package and copy all
the images in the package to the following locations:

* TCR Server Installation Drive\Program
Files\IBM\JazzSM\profile\installedApps\
JazzSMNode01Cel1\IBM Cognos.ear\p2pd.war\tivoli\
tcr_common\images

e TCR Server Installation Drive\Program
Files\IBM\JazzSM\reporting\cognos\webcontent\
tivoli\tcr_common\images

For more information about copying images, see the
“Copying report images to the server” topic in the m
[Tivoli Systems Management Information Center

(http:/ /pic.dhe.ibm.com/infocenter/tivihelp /v3rl/
topic/com.ibm.psc.doc_1.1.0.1/tcr_original/
tter_copying_images.html).
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Chapter 4. Support information

If you have a problem with your IBM software, you want to resolve it quickly.

IBM provides the following ways for you to obtain the support you need:
Online
The following websites contain troubleshooting information:
+ Go to the [IBM Software Support website| (http:/ /www.ibm.com/support/entry/portal/
software) and follow the instructions.

* Go to the|Application Performance Management Wiki| (http:/ /www.ibm.com/developerworks/
servicemanagement/apm/index.html). Feel free to contribute to this wiki.

IBM Support Assistant
The IBM Support Assistant (ISA) is a free local software serviceability workbench that helps you
resolve questions and problems with IBM software products. The ISA provides quick access to
support-related information and serviceability tools for problem determination. To install the ISA
software, go to the IIBM Support Assistant Website| (http:/ /www.ibm.com/software/support/isa).
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Chapter 5. Informational, warning, and error messages
overview

Messages relay information about how the system or application is performing and can alert you to
exceptional conditions when they occur.

Messages are sent to an output destination, such as a file, database, or console screen.

If you receive a warning or error message, you can do one of the following actions:
* Follow the instructions listed in the Detail window of the message if this information is included there.
* Consult the message details listed in this topic to see what action you can take to correct the problem.

* Consult the message log for message ID, text, time, and date of the message, as well as other data you
can use to diagnose the problem.

Message format

The message format contains a message ID and text, an explanation, and an operator response.

IBM Tivoli Composite Application Manager for Microsoft Applications: Microsoft Hyper-V Server Agent
messages have the following format:

Message ID and text
Explanation
Operator Response

The message ID has the following format:
CCC####severity

where:

CCC  Prefix that indicates the component to which the message applies. The following components are
used:

KHV  General Microsoft Hyper-V Server agent messages
#HH#  Number of the message

severity
Severity of the message. Three levels of severity are used:

I Informational messages provide feedback about something that happened in the
product or system that might be important. These messages can provide guidance
when you are requesting a specific action from the product.

W Warning messages call your attention to an exception condition. The condition
might not be an error but can cause problems if not resolved.

E Error messages indicate that an action cannot be completed because of a user or
system error. These messages require user response.

The Text of the message provides a general statement regarding the problem or condition that occurred.
The Explanation provides additional information about the message and the possible cause for the
condition. The Operator Response provides actions to take in response to the condition, particularly for
error messages (messages with the "E" suffix).
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Note: Many message texts and explanations contain variables, such as the specific name of a server or
application. Those variables are represented in this topic as symbols, such as "&1." Actual messages
contain values for these variables.

Agent messages

The following messages apply to IBM Tivoli Composite Application Manager for Microsoft Applications:
Microsoft Hyper-V Server Agent.

KHV0001I
The Hyper-V Virtual Machine Management Service was started.

Explanation:
The Hyper-V Virtual Machine Management Service was started.

Operator response:
None.

KHV00021
The Hyper-V Virtual Machine Management Service is already started.

Explanation:
The Hyper-V Virtual Machine Management Service is already started.

Operator response:
None.

KHVO0003E
Error starting the Hyper-V Virtual Machine Management Service.

Explanation:
Error starting the Hyper-V Virtual Machine Management Service.

Operator response:
Check the event log for more information.

KHV0008I
The Hyper-V Image Management Service was started.

Explanation:
The Hyper-V Image Management Service was started.

Operator response:
None.

KHV00091
The Hyper-V Image Management Service is already started.

Explanation:
The Hyper-V Image Management Service is already started.

Operator response:
None.

KHVO0008E
Error starting the Hyper-V Image Management Service.

Explanation:
Error starting the Hyper-V Image Management Service.

Operator response:
Check the event log for more information.

KHV0015I
The Hyper-V Networking Management Service was started.
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Explanation:
The Hyper-V Networking Management Service was started.

Operator response:
None.

KHV00161
The Hyper-V Networking Management Service is already started.

Explanation:
The Hyper-V Networking Management Service is already started.

Operator response:
None.

KHVO0017E
Error starting the Hyper-V Networking Management Service.

Explanation:
Error starting the Hyper-V Networking Management Service.

Operator response:
Check the event log for more information.

KHV0082I
The Hyper-V Virtual Machine Management Service was stopped.

Explanation:
The Hyper-V Virtual Machine Management Service was stopped.

Operator response:
None.

KHV0083I
The Hyper-V Virtual Machine Management Service is already stopped.

Explanation:
The Hyper-V Virtual Machine Management Service is already stopped.

Operator response:
None.

KHV0084E
Error stopping the Hyper-V Virtual Machine Management Service.

Explanation:
Error stopping the Hyper-V Virtual Machine Management Service.

Operator response:
Check the event log for more information.

KHV0108I
The Hyper-V Image Management Service was stopped.

Explanation:
The Hyper-V Image Management Service was stopped.

Operator response:
None.

KHV0102I
The Hyper-V Image Management Service is already stopped.

Explanation:
The Hyper-V Image Management Service is already stopped.
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Operator response:
None.

KHVO0103E
Error stopping the Hyper-V Image Management Service.

Explanation:
Error stopping the Hyper-V Image Management Service.

Operator response:
Check the event log for more information.

KHV01051
The Hyper-V Networking Management Service was stopped.

Explanation:
The Hyper-V Networking Management Service was stopped.

Operator response:
None.

KHV01061
The Hyper-V Networking Management Service is already stopped.

Explanation:
The Hyper-V Networking Management Service is already stopped.

Operator response:
None.

KHVO0107E
Error stopping the Hyper-V Networking Management Service.

Explanation:
Error stopping the Hyper-V Networking Management Service.

Operator response:
Check the event log for more information.

KHV0100W
The service does not exist as an installed service.

Explanation:
The service does not exist as an installed service.

Operator response:
None.

KHV01011
The service is disabled and cannot be started.

Explanation:
The service is disabled and cannot be started.

Operator response:
None.

KHV0104S
The virtual machine is successfully started.

Explanation:
The virtual machine is successfully started.

Operator response:
None.
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KHV0104F
Error starting the virtual machine.

Explanation:
Error starting the virtual machine.

Operator response:
None.

KHV0105S
The virtual machine is successfully stopped.

Explanation:
The virtual machine is successfully stopped.

Operator response:
None.

KHVO0105F
Error stopping the virtual machine.

Explanation:
Error stopping the virtual machine.

Operator response:
None.

KHV0105G
The Virtual Machine is already started.

Explanation:
The Virtual Machine is already started.

Operator response:
None.

KHV0105H
The Virtual Machine is already stopped.

Explanation:
The Virtual Machine is already stopped.

Operator response:
None.

KHV0105]
Resource Metering for all Virtual Machines enabled.

Explanation:
Resource Metering for all Virtual Machines enabled.

Operator response:
None.

KHV0105K
Resource Metering for Virtual Machines is not supported.

Explanation:
The Virtual Machine Resource Metering is not enabled.It is supported only on Windows
Server 2012 Operating System.

Operator response:
None.

KHV01051
No Virtual Machine available for enabling Resource Metering.
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Explanation:
No Virtual Machine available for enabling Resource Metering.

Operator response:
None.
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Appendix. ITCAM for Microsoft Applications documentation
library

Various publications are relevant to the use of ITCAM for Microsoft Applications.

For information about how to access and use the publications, see [Using the publications|
(http:/ /www.ibm.com/support/knowledgecenter /SSTFXA_6.3.0.1/com.ibm.itm.doc_6.3/common/
using_publications.htm).

To find publications from the previous version of a product, click Previous versions under the name of
the product in the Contents pane.

Documentation for this product is in the [TCAM for Microsoft Applications Knowledge Center|
(http:/ /www.ibm.com/support/knowledgecenter /SSDKXQ_6.3.1/com.ibm.itcamms.doc_6.3.1/
welcome_msapps631.html)

* Quick Start Guides
* Offering Guide
¢ Download instructions

* Links to Prerequisites
¢ Installation and Configuration Guide for each agent
* Link to Reference information for each agent

* Link to Troubleshooting Guide for each agent

Prerequisite publications

To use the information about the agents effectively, you must have some prerequisite knowledge.

See the following information at the [[BM Tivoli Monitoring Knowledge Center] (http:/ /www.ibm.com/
support/knowledgecenter /SSTFXA_6.3.0.2/com.ibm.itm.doc_6.3fp2/welcome.htm) to gain prerequisite
knowledge:

 IBM Tivoli Monitoring Administrator’s Guide
* IBM Tivoli Monitoring Installation and Setup Guide
* IBM Tivoli Monitoring High Availability Guide for Distributed Systems

* IBM Tivoli Monitoring: Installation and Configuration Guides for the following agents: Operating
System agents and Warehouse agents

 IBM Tivoli Monitoring: User's Guides for the following agents: Agentless OS monitors, Log file agent,
System p agents, Systems Director base agent

 IBM Tivoli Monitoring Agent Builder User’s Guide
 IBM Tivoli Monitoring Command Reference

* IBM Tivoli Monitoring: Messages

* IBM Tivoli Monitoring Troubleshooting Guide

+ IBM Tivoli Monitoring: References for the following agents: Operating System agents and Warehouse
agents

* IBM Tivoli Monitoring: Troubleshooting Guides for the following agents: Operating System agents and
Warehouse agents

* Tivoli Enterprise Portal User’s Guide
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Related publications

The publications in related information centers provide useful information.

See the following information centers, which you can find by accessing [Tivoli Documentation Centrall
(https:/ /www.ibm.com/developerworks/community /wikis /home?lang=en#! /wiki/Tivoli
%20Documentation%?20Central):

* Tivoli Monitoring

* Tivoli Application Dependency Discovery Manager
* Tivoli Business Service Manager

* Tivoli Common Reporting

* Tivoli Enterprise Console

* Tivoli Netcool/OMNIbus

Tivoli Monitoring Community on Service Management Connect

Service Management Connect (SMC) is a repository of technical information that is organized by
communities.

Access Service Management Connect at https:/ /www.ibm.com/developerworks/servicemanagement|

For information about Tivoli products, see the |[Application Performance Management communityl
(http:/ /www.ibm.com/developerworks/servicemanagement/apm/index.html).

Connect, learn, and share with Service Management professionals. Get access to developers and product

support technical experts who provide their perspectives and expertise. You can use SMC for these

purposes:

* Become involved with transparent development, an ongoing, open engagement between other users
and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

» Connect one-on-one with the experts to collaborate and network about Tivoli and the Application
Performance Management community.

* Read blogs to benefit from the expertise and experience of others.
* Use wikis and forums to collaborate with the broader user community.

Other sources of documentation

You can obtain additional technical documentation about monitoring products from other sources.

See the following sources of technical documentation about monitoring products:

. IIBM Integrated Service Management Libraryl (http:/ /www.ibm.com/software /brandcatalog/
ismlibrary/) is an online catalog that contains integration documentation as well as other
downloadable product extensions.

+ [IBM Redbook publications| (http:/ /www.redbooks.ibm.com/) include Redbooks® publications,
Redpapers, and Redbooks technotes that provide information about products from platform and
solution perspectives.

. (http:/ /www.ibm.com/support/entry/portal/software), which are found through the IBM
Software Support website, provide the latest information about known product limitations and
workarounds.
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Notices

This information was developed for products and services offered in the US. This material might be
available from IBM in other languages. However, you may be required to own a copy of the product or
product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of

the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions.
Actual results may vary.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to
non-IBMproducts. Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate

them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprises is
entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work
must include a copyright

notice as follows:

© (your company name) (year).

Portions of this code are derived from IBM Corp. Sample Programs.

© Copyright IBM Corp. 2008, 2016.
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml]

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

«

-'__\__._)

Ja\_.ré

COMPATIBLE

Java™ and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following terms and conditions.
Applicability

These terms and conditions are in addition to any terms of use for the IBM website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all
proprietary notices are preserved. You may not distribute, display or make derivative work of these
publications, or any portion thereof, without the express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that
all proprietary notices are preserved. You may not make derivative works of these publications, or
reproduce, distribute or display these publications or any portion thereof outside your enterprise, without
the express consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not

being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.
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IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering's use of cookies is set forth in the
following paragraphs.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user's user name for purposes of session management, authentication, and single sign-on
configuration. These cookies can be disabled, but disabling them will also likely eliminate the
functionality they enable.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See
IBM's Privacy Policy at fhttp:/ /www.ibm.com/privacy|and IBM's Online Privacy Statement at

http:/ /www.ibm.com /privacy/details| the section entitled “Cookies, Web Beacons and Other
Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at

http:/ /www.ibm.com /software /info/product-privacy}
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